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Copyright
Copyright ©2007 Recordex USA, Inc.  All rights reserved. No part of this user’s guide may be reproduced in any
form without the express written permission of Recordex USA, Inc.  Note: User’s are permitted to print copies of
this guide for personal use.

Trademarks
Recordex and all Recordex product name are the registered trademarks of Recordex USA, Inc.  All other trademarks
acknowledged.  Apple™ is a registered trademark of Apple Computer, Inc.

Disclaimer
The information in this document is subject to change without notice.

RECORDEX USA, INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL., EITHER EXPRESS OR
LIMITED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO MARKET-
ABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PAT-
ENT.  RECORDEX USA, INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF
ANY NATURE, OR LOSSES EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.

Information & Support
Before calling for support please read the user’s guide and refer to Chapter 7: Troubleshooting for advice on resolving
common problems.  Should service be necessary please contact the Recordex Reseller where you purchased your duplica-
tor, or contact us using the contact information below.

  Recordex USA, Inc.
  PO Box 848
  105 North Anderson Drive
  Swainsboro, GA 30401
  1-478-237-5501

Supplies
Your StudioJet™ will perform at peak operation when you use high-quality inkjet printable media.  Please contact the
authorized Recordex retailer/dealer where you purchased your duplicator and ask them to recommend their highest
quality media.  Using high quality media will ensure quick and error-free duplication.  Your Recordex retailer/dealer
also sells replacement ink cartridges for your StudioJet autoprinter.

To achieve the highest quality print results we recommend water proof media by Kodak Media Products.  Ask your Recor-
dex retailer or dealer about premium printable media from Kodak Media Products.

Recommended for use with:
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Warranty

Limited 1-year Warranty on StudioJet™ Commercial Color CD/DVD Autoprinter

W Recordex warrants to the original purchaser only that the CD/DVD autoprinter will be free from defects in
material and workmanship under normal use for a period of one (1) year from the date of original purchase. However, Recordex
does not warrant against failures related to poor quality media or the use of refilled or refurbished inkjet cartridges. Recordex's
warranty shall not apply: (i) to any autoprinter subjected to accident, misuse, neglect, alteration, acts of God, improper handling,
improper transport, improper storage, improper use or application, improper installation, improper testing or unauthorized re-
pair; or (ii) to cosmetic problems or defects that result from normal wear and tear under ordinary use, and do not affect the per-
formance or use of the product. If the autoprinter develops a covered defect within the first year, Recordex will, at its option,
either repair or replace the autoprinter at no charge, provided that the autoprinter is returned during the warranty period.

 One (1) year from the date of the original purchase.

You are responsible for shipping the printer to our Printer Service Depot.  Recordex will pay for
return shipment of printers repaired under warranty.  Return shipment will be by ground service to the 48 contiguous US states.
You are responsible for shipping to Alaska, Hawaii and any address outside of the United States. If the printer is repaired out of
warranty then you are responsible for shipping both ways.

 To obtain warranty service please contact Recordex's Customer Service Center at
1-478-237-5501 or contact your authorized Recordex Dealer for assistance in filing a warranty claim. You will receive instruc-
tions on how to properly return your product for authorized warranty repair. In order to receive warranty service you must be able
to provide an original receipt for the purchase of your duplicator.

THE ABOVE STATED WARRANTY IS EXCLUSIVE AND REPLACES ALL OTHER WARRANTIES EXPRESSED OR IMPLIED INCLUDING
THOSE OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. RECORDEX WILL NOT BE HELD LIABLE FOR ANY
OTHER DAMAGES OR LOSS INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES AND LOSS OF PROFITS OR REVENUES
FROM WHATEVER CAUSE, INCLUDING BREACH OF WARRANTY OR NEGLIGENCE.

Returning Product

Limited 30-day return policy on StudioJet™ Commercial Color CD/DVD Autoprinter

Can I return my printer? The specific return policy for your printer will depend on the return policy of the Recordex
retailer/dealer where you purchases your autoprinter.

What is the factory policy?  Recordex will not accept any returned printers if the ink cartridges have been installed.  Once
the printer has been opened and ink cartridges have been installed the user agrees to keep the printer and the 30-day
refund policy is voided.  If there is a manufacturer defect with your printer we will make sure that your printer is repaired
or replaced, at our discretion, during the first 12-months of ownership.
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The following type conventions, terms, symbols, and abbreviations are used to make it easier for you to navigate the infor-
mation contained in this Users’s Guide.

Symbols
CAUTION: Indicates a caution warning regarding operation of the system that may lead to personal injury or dam-
age to the autoprinter.  Be sure to take careful note of any instruction flagged with a caution symbol.

IMPORTANT: Indicates a note regarding the proper use of the autoprinter.  For best results you should pay careful
attention to instructions flagged with the important information symbol.

NOTE: Indicates a note that may provide useful information regarding operation of your autoprinter.  Reading
these notes will help you to better understand how your autoprinter operates

!

i

2
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Customer Support
Your autoprinter was subjected to rigorous quality control testing and inspection, however, if your system is not working
properly please contact our support department so we can ensure that your autoprinter is running properly.  We strive to
build the best product possible and we desire that every customer feel confident recommending Recordex products to their
friends.  If you are not fully satisfied please call our Customer Service Center today and we will do our best to make things
right.

 Customer Service Center
 Recordex USA, Inc.
 PO BOX 848
 105 North Anderson Drive
 Swainsboro, GA 30401
 P. 1-478-237-5501
 F. 1-478-237-5504

Safety Precautions
Please read through these important safety precautions and recommendations before setting up your autoprinter
to ensure safe and trouble free operation.

Autoprinter are high-precision electronic devices.  Do not use them in any manner other than as specified in this
user’s guide.

To prevent fire, shock, or other health risks do not expose the unit to moisture or rain.

To prevent electronic shock do not attempt to disassemble or modify the autoprinter or any of its internal compo-
nents.  Refer all servicing to authorized service centers.

The autoprinter warranty will become void if the unit is modified or serviced by unauthorized personnel.

Operating Environment
Before unpacking your autoprinter select an appropriate operating environment for your system.  You should look for an
area that meets these criteria:

· A level and stable work surface,

· In an area with good ventilation, low dust and no smoke,

· With moderate temperature and humidity,

· And access to an outlet with stable power

  Consider using an uninterruptible power supply with surge protection (UPS) to protect your duplicator.

You’re autoprinter is able to operate in both 110 and 220V environments.  The factory default is 110V but if you
live an a region of the world that operates at 220V you can simply use a standard computer power cord for your
region of the world.

!

!

!

!

!

i
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i Important:  Your autoprinter will not oper-
ation properly if installed on a surface
that is not level.  For discs to feed proper-
ly the autoprinter must rest on a level sur-
face.
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Unpacking Your StudioJet™ CD/DVD Autoprinter
Take a moment to make verify the contents of your StudioJet™ package.

Your StudioJet™ package contains:

1    One (1) Recordex StudioJet™ CD/DVD Autoprinter
2 Four (4) Disc Input Spindles
3 One (1) Disc Output Tray
4 One (1) Power Cord & AC Adapter
5 One (1) 6’ USB Cable
6 One (1) Black Ink Cartridge and One (1) Color Ink Cartridge
7 One (1) StudioJet™ Setup Disc
8 One (1) Manual and One (1) Quick Start Guide

Figure 1.0 Contents of StudioJet™ box.

1

2

4

53
6

7

NOTE:  StudioJet 50™ AutoPrinter Depicted.  StudioJet 100™
AutoPrinters will include a larger 100 capacity output bin and
longer input spindles.
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1- Printer Cover

2- Disc Input Bin

3- Disc Print Tray

4- Power Button

5- Disc Output Bin

6- Resume Button

7- Cartridge LED

8 - Tray Open/Close

9 - Cancel Print

1 - Printer Cover
2 - Disc Input Bin ( 50 Capacity) (StudioJet 100 equipped with 100 Capacity Input Spindles)
3 - Disc Print Tray
4 - Power Button (Power button LED will flash while printer is printing)
5 - Disc Output Bin (50 capacity) (StudioJet 100 equipped with 100 Capacity Output Bin)
6 - Resume Button (This LED will flash to indicate that action must be taken, I.e. Insert new disc, clear an
error from the print queue.)  When no error is present pressing this button will simply load a disc into
the disc tray.
7 - Cartridge LED (This LED will flash when the ink cartridges are low.  It will also alert you to improper
cartridge installation, or it will flash whenever the cover is open.)
8 - Tray Open/Close Button (pressing will open the disc tray)
9 - Cancel Print (pressing will cancel the current print job)

NOTE:  StudioJet 50™ AutoPrinter Depicted.  StudioJet 100™
AutoPrinters will include a larger 100 capacity output bin and
longer input spindles.
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Taking a minute to make sure that your StudioJet™ autoprinter is setup properly will make operation smoother and more
enjoyable.

Location
Next, pick a well suited location to setup your duplicator.  You should choose a level and stable work surface in an area
with good ventilation, moderate temperature and humidity, and access to a grounded power outlet.

           Consider using an uninterruptible power supply with surge protection (UPS) to protect your duplicator.

A. Assembling Your StudioJet™

1.  Mount the disc input spindles by screwing them into the base of the disc input hopper (see Figure 2.0).

2.  Mount the disc output tray by sliding it into the lower right base of the printer stand (see Figure 2.1).  You will feel
a slight click when the tray has been slid all the way into the printer base.

B.  Connecting Power to Your StudioJet™

1.  Connect the power cord to the AC power adapter brick.

2.  Connect the small power connector to the back of the printer.

3.  Connect the power cord to a grounded 110 power outlet.  At this time the green LED on the front right of the print-
er will turn on indicating that the printer has power.  You may also hear the printer fan running.  This fan helps to keep
the printer cool and helps to clear the interior of the printer from ink spray.

i

Figure 2.0 Mounting Disc Input Spindles Figure 2.1 Mounting Disc Output Tray
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C.  Installing The Ink Cartridges

NOTE: Make sure the printer is powered on.  You can not install the printer cartridges unless the unit is powered on.

1.  Lift the front printer cover and wait until the ink cartridge cradle is all the way to the right of the printer and is idle.

2.   Remove the Black Ink Cartridge from its packaging.  Remove the protective plastic tape being careful not to touch
the copper electrical contacts on the bottom and rear of the cartridge (figure 2.3).

3.  Open the gray cartridge cover (56) and install the black cartridge.  Hold the print cartridge so that the label side
is facing up and the text is facing you as shown in Figure 2.2 below.  Slide the print cartridge in until it snaps into
place.  Do not force the cartridge into place.  After the cartridge has been installed snap the gray cartridge cover
closed.

4.   Remove the Color Ink Cartridge from its packaging.  Remove the protective plastic tape being careful not to touch
the copper electrical contacts on the bottom and rear of the cartridge.

5.  Open the Blue cartridge cover (57) and install the color cartridge.  Hold the print cartridge so that the label side is
facing up and the text is facing you as shown in Figure 2.2 above.  Slide the print cartridge in until it snaps into place.
Do not force the cartridge into place.  After the cartridge has been installed snap the blue cartridge cover closed.

6.  Close the printer cover and wait for the cartridges to be initialized by the StudioJet printer.  While the cartridges
are being initialized the green/orange LED’s on the left side of the printer will blink.  Wait for the LED’s to stop blink-
ing before using the printer.

C.  Load Inkjet Printable Media

1.  Load up to 50 discs, with the print surface facing up,
      into the disc input bin (see figure 2.4).

NOTE:   Insert the
cartridge so that the
label side is up and
the text is facing you
as shown in the image
to the left.

Do not force the car-
tridge into place.

i

Figure 2.3 Proper Orientation of Inkjet Cartridges

Figure 2.3

!

Figure 2.4 Loading Disc Input Bin

NOTE:  Your StudioJet™
printer uses standard Hewl-
ett Packard Ink Cartridges.

REPLACE WITH
HP 56 Black
HP 57 Color

i
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D.  Installing the StudioJet Driver

NOTE: Make sure the printer is powered on.

1.  Insert the StudioJet™ driver disc into the CD drive of you
computer.  Windows autorun should initiate the install pro-
gram after a few seconds (Figure 2.5). Do not start the in-
stall.  Simply move on to step 2.

NOTE: If the setup screen is not visible after a minute then au-
torun is likely disabled on your computer and you will need to
start the install program manually.  To do this click Start -->
Run --> Browse --> then select “My Computer” and then your
CD drive.  Locate setup.exe and double click to launch the
install program.

2.  Connect the autoprinter to your PC running Windows XP
(SP2) or Windows Vista using the supplied USB 2.0 cable.
The USB connector is located on the right-rear side of the print-
er.

3.  Your computer will report that it has found new hardware
and the Found New Hardware Wizard will start (Figure 2.6).
The Found New Hardware Wizard will ask if you want Win-
dows to search for a driver. Select “No, Not this time.” and
then click Next.

4.  The wizard will ask you where to look for the driver.  Se-
lect “Install the software automatically” and then click Next
(Figure 2.7).  The wizard will pull the StudioJet driver from the
install CD and begin installing the driver.

5.  This version of our printer driver has not yet been autho-
rized by the Windows Logo Testing lab.  However, we guar-
antee that our printer driver is safe for installation.  Simply
click “Continue Anyway” to complete the installation (Figure
2.8).

Figure 2.6

Figure 2.5

Figure 2.7

Figure 2.8
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D.  Installing the StudioJet Driver

NOTE: Make sure the printer is powered on.

6.  The install program will begin copying the necessary files
to your computer (Figure 2.9).

7.  The installation process will complete in just a few minutes.
Click Finish to close the installation wizard.

8.  To print a test page click Start and then Printers and Fax-
es and right click on the StudioJet printer.  Then select Print-
ing Preferences from the menu (Figure 2.11 and 2.12).

9.  Select the Utilities tab and then click Test Print and your
printer should begin printing a test disc within 10 to 20 sec-
onds.  Click OK to exit the printer preferences menu.

Figure 2.9

Figure 2.12

Figure 2.11

Figure 2.10

Figure 2.13
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D.  Installing the Apple QuickTime 7.0 &
Discus Label Editor LE 3.15

NOTE: Discus requires QuickTime 7.0 or later in order to func-
tion properly.

1.  Click on the Install QuickTime 7.0 button and then follow
the QuickTime installation wizard through the install process.

  NOTE: If QuickTime is already installed on your com-
puter then the install program will ask if you want to remove
or repair the current install of QuickTime.  You should click
Cancel (Figure 2.15) and then click Finish on the next screen
(Figure 2.16).

Figure 2.14

Figure 2.15: If QuickTime is already installed.

Figure 2.16: If QuickTime is already installed.

i
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D.  Installing the Apple QuickTime 7.0 &
Discus Label Editor LE 3.15

NOTE: Discus requires QuickTime 7.0 or later in order to func-
tion properly.

2.  Now you are ready to install Discus LE 3.15 for the Studio-
Jet.  Click the Install Discus Label Editor for StudioJet button
to launch the Discus install wizard (Figure 2.17).

3.  You must accept the Discus license agreement before in-
stalling Discus.  Click Next to continue (Figure 2.18)

4.  Enter a User and Organization Name (Optional, you may
leave these blank), and then click Next (Figure 2.19) The in-
stall wizard will copy the necessary files to your computer.
This may take a few minutes.

5.  After the files have been copied click Finish to close the
Install Shield Wizard for Discus LE (Figure 2.20).

6.  You may now click Exit on the StudioJet Driver setup
screen.

Figure 2.17

Figure 2.19

Figure 2.18

Figure 2.20

The serial number for your copy of Discus is
located on the install disc.  You will need this
the first time you open Discus.

i
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Your StudioJet™ printer is equipped with an advanced disc printer driver with built in image masking which enables you to
print a perfectly round image from virtually any Windows application.  This means that you do not need to worry about
cropping or modifying a photo or image to make it round.

First a few reminders about media and ink:
• Capacity: Your autoprinter can hold and print up to 50 discs before needing to be reloaded.  You can send a print
job of more than 50 copies but you will need to reload the printer as it gets low on discs.
• Disc Quality:  You should use high quality ink-jet printable media.  Recordex recommends water proof ink-jet me-
dia by Kodak Media Products for best results.  This media is available wherever you purchased your printer.
• Print Surface:  Only use ink-jet printable media.  Using non-inkjet printable media will create a mess of ink as the
ink will not be able to adhere to the disc surface.
• Ink Cartridges: Only use HP replacement ink cartridges for your StudioJet.  Attempting to refill the ink cartridge is
highly discouraged.  You will experience poor quality and may damage your printer.  Refilled cartridges do not have
the same internal pressure as a new cartridge and there is a much greater chance that they will leak into your printer.
Check with your Recordex Dealer or local retailer for quality original HP Ink Cartridges.

Using Discus to Create A Label

Refer to the Discus user manual for how to use Discus to create an attractive disc label.  You can access the manual by open-
ing Discus and then clicking on the Help Menu and choosing User Manual. (Figure 3.1)

The inside and outside diameter of the printable area of an inkjet printable discs often varies slightly from brand to brand.
For this reason it is sometimes necessary to print a sample disc and then make minor adjustments to the print settings.  If you
are using Discus you should use the print tab to change these settings.  If you are using another program to create your disc
label then you should refer to pages 17-21 for instructions on changing the print settings using the printer driver.

See the next page for instructions on using Discus to change the size of the print area.

Figure 3.1: Opening User Manual
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Using Discus to Create A Label

(Figure 3.2).

Clicking Setup will open the printer dialog box.  From here you can click Properties to enter the printer driver settings menu.
This is where you can select the print quality.  For non-photo printing you will normally find Normal or Fast Normal to be
sufficient quality and this will save you ink.  However, for best results when printing photos we recommend using water-
proof glossy inkjet media and setting the print quality to Best.

To print multiple copies you simple enter the number of copies you want to print in the printer dialog box and click print.
Your StudioJet™ will automatically load, print and eject however many discs you request to be printed.

1
2

Outside and Inside Diameter Settings

1 - Outside diameter
Reduce if you are getting ink past
the outside printable area of the
disc.
Increase if your image is not print-
ing all the way to the edge of the
printable area.

2 - Inside diameter
Reduce if your image is not print-
ing all the way to the inside diam-
eter of the printable area.
Increase if your image is printing
on the inside hub of the disc on the
non-printable surface.

3 Adjusting the center offset - moving
the image up, down or side to side

3 - Center Offset
Reset. Clicking the middle circle
will return all offset settings to
zero.
Adjust. Clicking the arrows will
move the image in that direction
by one tenth of a millimeter.

Figure 3.2 Adjusting The Size & Offset of the print image
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Using Your Preferred Graphics Program to Create Disc Labels

Your StudioJet™ autoprinter is equipped with a special printer driver designed to automask an image for printing to discs.
You can modify the masking settings to enable printing to hub printable and non-hub printable inkjet discs.  This section will
walk you through using your preferred graphics program to create a disc label.

Open your graphics program and select Page Setup from the File menu.  First make sure that the StudioJet is the selected
printer.

In most cases you can select the paper type from a drop down box, if this is the case then 120mm disc should show up in
the drop down list.  Selecting this will in most cases automatically enter the correct page size.  If this does not work then you
can manually set the page size to the following settings:

Page Size:  5.33” Wide x 5.33” High

Next you will want to make sure that the printer margins are set correctly.  Use these settings:

Margins: Set top, bottom, left and right margin to 0.3”

Create the document as you would normally do so and when you are finished print the document using the StudioJet printer
driver.   You may want to print a single disc first to make sure that the image is aligned properly.  If you need to change
the inside or outside diameter or the center offset (I.e. Move image up, down, left or right) then refer to Chapter 4: Printer
Driver Settings.

  NOTE: Some applications will not properly retrieve the correct
page size from the printer driver.  In these cases even when you select
120 mm disc as the paper type you will notice that the page size is still
8.5 x 11.  If this is the case then you should still set the margins to .3 and
create your design in the upper left corner of the document.  You can then
print to the StudioJet and your image should be properly aligned.

i
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This section will provide you with an overview of the options and settings available through the printer driver preferences.

Accessing Printer Driver Preferences

1.  Through the start menu by clicking Start, then Printers & Faxes,
and then right-clicking on Printing Preferences (Figure 4.1).

OR

2.  Within the program you are using to create the disc label
select Print from the File menu (make sure StudioJet is selected)
and then click on Properties (Figure 4.2).

Figure 4.1: Accessing Printer Properties

Figure 4.2: StudioJet Printer Properties
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Accessing Printer Driver Preferences

Your StudioJet™ is pre-configured to be used
with standard size (120mm) inkjet printable discs.

You do not need to change the Size or Type options.

Print Quality
There are six print qualities settings:

Printer Default (which is set to Normal)
Fast Draft (Fastest print, lowest quality)
Fast Normal (Fast printing, good quality)
Normal (Quick printing, better quality)
Best (Slower printing, very high quality)
Maximum dpi (Slow printing, maximum quality)

Note, that as you increase print quality you increase
ink consumption and print time.  Here is a list of our
recommended print quality settings based on the
type of image you are printing:

Text only - Try Fast Draft, or Fast Normal
Text with Small Graphic - Fast Normal
Text with Small Photo - Fast Normal or Normal
Large Graphic - Normal
Large Photo - Normal or Best

Orientation: This setting will not have an impact on
printing disc images since the medium is circular.

Page Order: If you are printing a multi page document
this will alter the order that the discs images are
printed.

Copies: Leave this set to 1 since you’ll want to use the
copies setting in the print dialog box when you print
from an application.

Advanced Features: You can alter the saturation level
by moving the slider from low to heavy.  We do not
recommend making changes to the dry time setting.

Figure 4.3: Paper/Quality

Figure 4.4: Basics
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Accessing Printer Driver Preferences

Color Options
To print in grayscale without needing to alter

 source images check Print in Grayscale.
  NOTE: The Black print cartridge only option
  will not work with the StudioJet™.

 To print in sepia without altering the image just
 check Print in sepia.

 Advanced Color Settings...
 This will open a menu that allows you to alter
 ink saturation levels for each color.  We
 recommend leaving these values at their default
 unless you are experienced in using alternate
 ink saturation levels to achieve a desired
 print result.

Color Space
 sRGB/sYCC is the standard used for most
 applications.  If you are familiar with AdobeRGB
 and know when it is applicable to use AdobeRGB
 then feel free to change the color space setting
 as necessary.

When Enable Masking is checked the printer driver
will automatically mask the print image so that nothing
prints outside the printable area of the disc.

Mask Type: Do not change this setting.  The StudioJet
only prints to standard size discs.

Standard Area Settings: The default settings (118, 38)
are appropriate for standard inkjet discs.  If your disc
has a slightly larger or small inside or outside
diameter you can change the settings here.

Hub Area Settings:  Many users like to use discs with
printable hubs.  These allow printing all the way to
the center of hole of the disc.  If you check  Printing
on Hub you will need to reduce the inner diameter
setting under Standard Area Settings to 35mm.

Mask Origin & Parameter Unit: Leave these set to
factory defaults (0,0, x1mm)

Figure 4.5: Color

Figure 4.6: Mask Settings
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Accessing Printer Driver Preferences

These utilities will help you to test and maintain your
printer.

Test Print: Prints an alignment image that is 116mm in
diameter to assist with changing printer alignment
settings.

Clean: At times, especially if the printer has not been
used for a while, the ink nozzles will need to be cleaned.
The clean utility will clean out the nozzles.

Demo Print:  The demo print button will send a photo
print job to the printer.  This is an easy way to verify
that the printer is working properly.

Ink Level:  The ink level indicator will only work while the
printer is printing.  These levels are not always 100%
accurate.  We recommend running cartridges until they
no longer print properly before replacing them.

Your StudioJet like any automated disc printer may
require minor alignment after shipping or being moved.
If you notice a consistent misalignment of the print image
you should alter center offset of the printer.

First go to the Utilities tab and print a Test Print which
will print a disc with an alignment pattern.  If the outside
diameter circle is not centered then adjust the offset
accordingly:

Move Up: Enter a negative value in the Y offset and
click offset.
Move Down: Enter a positive value in the Y offset and
click offset.
Move Right: Enter a positive value in the X offset and
click offset.
Move Left: Enter a negative value in the X offset and
click offset.

Figure 4.7: Utilities

Figure 4.8: Alignment

   Note: That the Ink Level utility will
not work if you have your printer connected
to the network with a wireless print server.

i

   Note: To save an offset value you
must click the Offset button.  Clicking OK
will not save an offset change.

i
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Your StudioJet™ requires very little maintenance but proper care will extend the life of your printer.

Ink
Only use authentic original HP Inks inks with your printer.  Using any ink other than original HP cartridges will void your
printer warranty.  Use only new original HP 56 or 57 cartridges.

Media
Using high-quality ink-jet printable media will produce the best results. Do not use media that is not designated as ink-
jet printable.

Cleaning Printer Exterior
Inkjet printers print by spraying a fine mist of ink from the print head onto the disc.  In some situations, small amounts of ink
from the printing process may be deposited on the printer case and become visible over time.  IF this situation occurs, the
exterior of the printer can be cleaned with a soft cloth, moistened with water to remove ink deposits, dust, smudges and
fingerprints.  A mild detergent may be used if necessary on the case exterior.  Do not use harsh household cleaners as they
may damage the finish on the printer case.

Do not spray water or cleaner onto the printer.  If you must use a cleaning agent we recommend
using a cloth that has been dampened with warm slightly soapy water.

We recommend using a micro-fiber cloth for cleaning the exterior of your printer.

Cleaning Printer Interior
All inkjet printers produce a small amount of ink residue that may build up inside the printer’s case.  This is normal.  There is
no need to clean this residue.  Alcohol or other cleaners may damage the printer and should not be used.  Cleaning the
interior of the printer should be limited to cleaning only the print cartridges.  Do not clean anything else inside the printer.
Keep all liquids away from the inside of the printer.

WARNING: Do not clean or lubricate the carriage rod.  Cleaning or lubricating the rod may reduce
its life.  The ink present on the rod will not hinder the operation of the printer.  The carriage rod is
the shaft inside the printer on which the print cartridges move back and forth.

Cleaning Ink Cartridges
Clean the Inkjet print cartridges when lines or dots are missing from printed text and graphics.  The missing lines and dots
will appear as white lines throughout the text and graphics.  The may be caused by the spray nozzles being clogged or by
the cartridge running out of ink.  If the inkjet cartridge print cartridge is low on ink, replace the cartridge.  If you know the
cartridge is not low on ink then try cleaning the cartridge.

To clean cartridges use the Clean utility included with the printer driver utilities.  To access the Clean utility click Start then
Printers and Faxes, right-click on StudioJet and click on Printing Preferences.  Then click on the Utilities tab and then click
Clean.  (See chapter 4 for further instructions).

Follow the on screen instructions for cleaning the ink cartridges.

!

i

!
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This chapter covers the most common problems that we have encountered.  If you are experiencing a problem there is a
good chance that the solution to your problem is in this chapter.  We ask that you please read through the frequently
asked questions and the common problems sections before calling for technical support.

Frequently Asked Questions

Q: How many discs can I print with a new set of ink cartridges?
A: This will vary based on what you are printing and the print quality setting that you use.  We’ve found that we can
print 300 to 400 discs with an average amount of text and color coverage (40%).  However, when printing photos you
may only be able to print 125 to 150 discs before running low on ink.  To extend ink life use the lowest print quality
acceptable.

Q: Can I send a print job with more than 50 or 100 copies?
A: Sure.  However, you’ll have to load additional media after the first 50 discs are printed (or 100 discs if you are
using a StudioJet 100).

Q: Can I print on CDs, DVDs, and Blu-ray discs?
A: You can print on any standard size (120 mm) optical disc that is inkjet printable.

Q: Can I print on business card discs or small discs?
A: No.  The StudioJet is designed for use with 120mm discs.  Our loading mechanism is the fastest in the industry and is
designed to provide superior performance with 120mm discs.  Unfortunately, we do not have an option at this time for
non-standard disc sizes.

Q: Can I hook my printer up to an Apple computer?
A: Not yet.  We are working on an Apple driver but we do not have one available yet.

Q: Can I print on Silver and White inkjet printable discs?
A: Yes.  We support all inkjet print surfaces.

Q: Can I print on any brand media.
A: The StudioJet was designed to work with any 120mm inkjet printable disc.  If you encounter a problem with a par-
ticular brand please let us know so we can investigate the problem.

Most Common Problems

PROBLEM: The printer is not on a leveled surface.
SYMPTOM: Discs do not load properly.
SOLUTION: Make sure the surface your printer is resting on is level.  If necessary use a bubble level to make sure the sur-
face is level both front to back and side to side.

PROBLEM: Ink cartridges are low or need cleaned.
SYMPTOM: Images are streaky, washed out, or have small white lines running through them.
SOLUTION: Run the clean cartridge utility.  See chapter 4.

PROBLEM: Image needs to be aligned.
SYMPTOM: There is ink on the outside edge or the inside hub of the discs.
SOLUTION: Use the disc alignment feature if you are using Discus to align the disc. Or alter the mask settings, or center
offset as necessary.  See Pages 20-21 for more information.
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LED's & Blinking Lights

LIGHT/LED   LIGHT/LED STATUS   MEANING

Power    Flashing      Printer is printing.

Power    Solid      Printer is on.

Power    Off       Printer is off.

Resume LED   On       Printer is waiting for a disc to be loaded
            or an error needs to be cleared before continuing.

Cartridge LED  On       Ink cartridges are getting low.

Cartridge LED  Flashing      Printer cover is open or cartridges are installed improperly
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MODELS    StudioJet 50™ Autoprinter
      StudioJet 100™ Autoprinter

DISC CAPACITY   StudioJet 50™  50 Disc Input Bin / 50 Disc Output Bin
      StudioJet 100™ 100 Disc Input Bin/100 Disc Output Bin

PRINT TECHNOLOGY Advanced Three Picoliter Inkjet

PRINT RESOLUTION  Up to 4800 dpi; Driver selectable

MEDIA TYPES   Standard Size (120mm) Inkjet Printable Disc

INK CARTRIDGES  Dual Ink Cartridge System (Tri-Color CMY & Black)
      Hewlett Packard HP 56 Black Ink Cartridge
      Hewlett Packard HP 57 Tri-Color Cartridge

COLORS    16.7 Million, Black Monochrome, Sepia

Pentium® 233 MHz or higher, at least 256 MB RAM, USB 2.0 Port, Windows XP(SP2) or Windows Vista, 50 MB Free Disk
Space.

DIMENSIONS    17.7” x 9.5” x 20.7”

WEIGHT    Printer: 19 lbs; Shipping Weight 25 lbs

POWER VOLTAGE  100-240VAC (Global Ready Universal A/C Power Brick)

POWER FREQUENCY 50-60Hz
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Every StudioJet™ is rigorously tested before it is shipped to ensure trouble free operation.  However, if your autoprinter
stops working properly don’t hesitate to give us a call.

Contact Technical Support

Recordex Technical Support
PO BOX 848
Swainsboro, GA  30401

1-478-237-5501

1-478-237-5504

service@recordexusa.com

CHECKLIST

1.  Check the Frequently Asked Questions List.

2.  Read the Common Problems list.

3.  Write down the model number & serial number
     of your duplicator.

 Model#:    _____________________

 Date of Purchase:  _____________________

 Place of Purchase:  _____________________

4.  Call 478-237-5501 ask for technical support.


